Introduction to Polylines

The PLINE command is used to draw polylines and any related objects made up of line segments. Polylines have many advantages over normal lines:

- They can be used to draw a single object comprised of arcs and straight lines of varying thicknesses.
- They can be drawn as thick or tapered lines.
- Polylines provide much more flexibility than lines.
- They can be used with any linetype.
- Polylines can be edited using specialized editing features.
- The area and perimeter of polylines can be determined easily.
Drawing Polylines

The function of the **PLINE** command is similar to the function of the **LINE** command. However, **PLINE** offers additional command options. Also, all segments of a polyline are treated as a single object. To draw a polyline, you can pick the **Polyline** button on the **2D Draw** control panel of the **Dashboard** or the **Draw** toolbar, pick **Draw > Polyline**, or type **PL** or **PLINE**.

A line width of 0.0000 produces a polyline of minimum width. If this is acceptable, select the endpoint of the line segment. If you draw additional line segments, the endpoint of the first line segment automatically becomes the starting point of the next line segment. When you are finished drawing line segments, press [Enter] or [Esc] to end the **PLINE** command.

**Setting the Polyline Width**

To change the width of a line segment, enter the **PLINE** command, select the first point, and use the **Width** option. When the **Width** option is selected, AutoCAD prompts you to specify the starting and ending widths of the line. The starting width value becomes the default setting for the ending width. Therefore, to draw a line segment with one width, press [Enter] at the second prompt. To create a tapered line segment, enter different values for the starting and ending widths. After the widths are specified, the rubberband line from the first point reflects the width settings. **Figure 14-1** shows a 4" long polyline with starting and ending widths of .25". Notice that the starting and ending points of the line are located at the center of the line segment's width.

**Drawing a Tapered Polyline**

By entering different starting and ending width values, you can draw a tapered polyline. In the example shown in **Figure 14-2**, the starting width is .25 unit, and the ending width is .5 unit. One special use of a tapered polyline is the creation of arrowheads. To draw an arrowhead, use the **Width** option of the **PLINE** command, specify 0 as the starting width, and then use any desired ending width.

**Using the Halfwidth Option**

The **Halfwidth** option of the **PLINE** command allows you to specify the width of the polyline from the center to one side. After picking the first point of the polyline, enter the **Halfwidth** option. Specify starting and ending values. Notice that the polyline in **Figure 14-3** is twice as wide as the polyline in **Figure 14-2**, even though the same values are entered.

---

**Figure 14-1.**
A thick polyline drawn using the **Width** option of the **PLINE** command.

**Figure 14-2.**
The **Width** option of the **PLINE** command can be used to draw a wide, tapered polyline.

**Figure 14-3.**
A thick polyline drawn using the **Halfwidth** option of the **PLINE** command.
Figure 14-3.
Specifying the width of a polyline with the **Halfwidth** option of the **PLINE** command. Notice that a starting value of .25 produces a polyline width of .5 unit and an ending value of .5 produces a polyline width of 1 unit.

**Using the Length Option**

The **Length** option of the **PLINE** command allows you to draw a polyline parallel to the previous polyline or line. After drawing a polyline, reissue the **PLINE** command and pick a starting point. Enter the **Length** option and give the desired length. The second polyline is drawn parallel to the previous polyline with the length you specified.

**Exercise 14-1**

Complete the exercise on the Student CD.

**Undoing Previously Drawn Polyline Segments**

To erase the last segment of a polyline without leaving the **PLINE** command, you can use the **Undo** option. To do so, type U and press [Enter]. Each time you use the **Undo** option, another line segment is erased. The segments are removed in reverse order from the order in which they were drawn. This is a quick way to go back and correct the polyline while remaining in the **PLINE** command.

After you press [Enter], the last polyline segment drawn is removed. The rubber-band is attached to the last end of the line segment that was drawn before the undone segment. You can now continue to draw additional line segments or undo another segment. You can use the **Undo** option to remove all the polyline segments up to the first point of the polyline. You cannot, however, specify a new first point for the polyline using this option.

**Exercise 14-2**

Complete the exercise on the Student CD.
The **Arc** option of the **PLINE** command is similar to the **ARC** command, except that the **Width** and **Halfwidth** options of the **PLINE** command can be used to set an arc width. The arc width can range from 0 to the radius of the arc. A polyline arc can also be drawn with different starting and ending widths by using the **Width** option. See **Figure 14-4**. The **Width** and **Arc** options can be entered in either order.

By default, a polyline arc continued from a previous line or polyline is tangent to the last object drawn. The arc's center is determined automatically, but you can pick a new center. You can also specify settings with one of the **Arc** suboptions of the **PLINE** command. These suboptions are **Angle**, **CEnter**, **Direction**, **Radius**, **Second pt** (second point), and **CLOSE**. The options are very similar to the **ARC** command options and are explained in the following sections.

### Specifying the Included Angle

The **Angle** suboption of the **PLINE Arc** option specifies an included angle for a polyline arc. The angle value is based on the number of degrees in a circle. Therefore, a value of 180 draws a half circle, 270 draws three quarters of a circle, and so on. The values 0 and 360 cannot be entered. A negative value draws the arc in a clockwise direction. **Figure 14-5** shows a polyline arc with an included angle of 60°.
Specifying a New Center Point

When a polyline arc is drawn as a continuation of a polyline segment, the center point of the arc is calculated automatically. You may want to pick a new center point if the polyline arc does not continue from another object or if the center point AutoCAD calculated is not suitable. The Center suboption allows you to specify a new center point for the arc. When you pick the center point, the arc's radius is set as the distance from the center point to the starting point. You can then choose from three methods to complete the polyline arc:
- Pick the endpoint of the arc
- Use the Angle option to specify the included angle
- Use the Length option to specify the chord length of the arc

Using the Direction Suboption

The Direction suboption alters the bearing of the arc. By default, a polyline arc is created tangent to the last polyline, arc, or line drawn. The Direction suboption is used to change this and can also be entered when you are drawing an unconnected polyline arc. It functions much like the Direction option of the ARC command.

After selecting the Direction suboption of the PLINE Arc option, specify the tangent direction for the start point of the arc. You can enter a numeric angle value, or you can pick a point to define the angle relative to the start point.

Drawing a Polyline Arc by Radius

Polyline arcs can be drawn by giving the arc's radius. Enter the Radius suboption of the PLINE Arc option, specify the radius, and then specify the second endpoint for the arc.

Specifying a Three-Point Polyline Arc

A three-point polyline arc can be drawn using the Second pt suboption. After entering the Second pt suboption, AutoCAD prompts you to pick the second point and endpoint of the arc.

Using the Close Suboption

The Close suboption saves drafting time by automatically adding the last segment to close a polygonal shape. Using this suboption of the PLINE Arc option closes the shape with a polyline arc segment, rather than a straight line segment. See Figure 14-6. CL is entered at the prompt line to distinguish this option from the Center suboption.

Exercise 14-3

Complete the exercise on the Student CD.

Figure 14-6.
Using the Close suboption to close a polygonal shape.
Filling Polylines and Traces

In the description of the PLINE command earlier in this chapter, the results were shown as if the objects were solid, or filled in. You can display polylines as filled objects or as an outline only. See Figure 14-7. These functions are controlled by the Apply solid fill setting in the Display performance area of the Display tab in the Options dialog box. This setting can also be changed by typing FILL or FILLMODE.

PROFESSIONAL TIP

When a drawing contains many wide polylines, it is best to turn solid fills off. This saves time when redrawing, regenerating, or plotting a check copy of the drawing. Activate solid fills for the final plotting.

Exercise 14-4

Complete the exercise on the Student CD.

Figure 14-7.
Examples of the FILL mode on and off.

Revising Polylines

Polylines are drawn as multiple segments. A single polyline can be drawn as a straight segment joined to an arc segment and completed with another straight segment. Even though you have drawn separate segments, AutoCAD puts them all together. The result is one polyline treated as a single object. When editing a polyline, you must either edit it as one object or divide it into its individual segments. These changes are made with the PEDIT and EXPLODE commands. The EXPLODE command is described later in this chapter.

The PEDIT command is accessed by picking the Edit Polyline button on the Modify II toolbar, selecting Modify > Object > Polyline, or typing PE or PEDIT. You can also select a polyline, right-click in the drawing area, and choose Polyline Edit from the shortcut menu.

When selecting a wide polyline, you must pick the edge of a polyline segment rather than in the center. If you want to edit more than one polyline, type M before selecting to access the Multiple option. If the object you select is a line or arc object, AutoCAD issues a prompt that gives you the option to turn it into a polyline. The command then continues normally. Its options are explained later in this chapter.

You can set AutoCAD to turn lines and arcs into polylines automatically without displaying the prompt. The value of the PEDITACCEPT system variable controls this feature. When it is set to 0, AutoCAD issues a prompt when a line or an arc is selected.
When the system variable is set to 1, AutoCAD automatically turns the selected lines and arcs into polylines. The command then continues normally.

Circles drawn with the `CIRCLE` command cannot be changed to polylines for editing purposes. Polyline circles can be created by using the `Arc` option of the `PLINE` command and drawing two 180° arcs or by using the `DONUT` command.

---

**PROFESSIONAL TIP**

A group of connected lines and arcs can be turned into a continuous polyline using the `Join` option of the `PEDIT` command. This option is described later in this chapter.

---

**Revising a Polyline As One Unit**

A polyline can be edited as a single object, or it can be divided into individual segments. The segments can then be revised individually. This section describes the options for changing the entire polyline. There is no default option for the `PEDIT` command; you must select one of the options.

---

**Opening and Closing a Polyline**

You may decide to close an open polyline or open a closed polyline. These functions are performed with the `Open` and `Close` options of the `PEDIT` command. Open and closed polylines are shown in Figure 14-8.

The `Open` option is only available if the polyline was closed using the `Close` option of the `PLINE` command. It is not displayed if the polyline was closed by drawing the final segment manually. Instead, the `Close` option is displayed. If you select an open polyline, the `Close` option is displayed instead of the `Open` option. Enter this option to close the polyline.

---

**Joining Polylines to Other Objects**

Connected polylines, lines, and arcs can be joined to create a single polyline. This is done with the `Join` option of the `PEDIT` command. The `Join` option works only if the polyline and other existing objects meet exactly. They cannot cross, nor can there be any spaces or breaks between the objects. See Figure 14-9.

Select each object to be joined or group the objects with one of the selection set options. The original polyline can be included in the selection set, but it does not need to be. See Figure 14-10. If you select lines and arcs to join, AutoCAD automatically converts these objects to polylines, regardless of the `PEDITACCEPT` setting.

---

**PROFESSIONAL TIP**

Once items have been joined into a continuous polyline, the polyline can be closed using the `Close` option of the `PEDIT` command.

---

![Figure 14-8. Open and closed polylines.](image)
Changing the Width of a Polyline

The *Width* option of the *PEDIT* command allows you to assign a new width to a polyline. The width of the original polyline can be constant, or it can vary. *All* segments will be changed, however, to the constant width you specify. An unedited polyline and the same polyline after using the *Width* option of the *PEDIT* command are shown in Figure 14-11. The width of donuts can be changed using this procedure as well.

**Exercise 14-5**

Complete the exercise on the Student CD.
Editing a Polyline Vertex or Point of Tangency

The Edit vertex option of the PEDIT command is used to edit polyline vertices and points of tangency. This option is not available if you have selected multiple polylines for editing. A polyline vertex is the point at which straight polyline segments meet, and a point of tangency is the point at which a polyline arc meets another polyline arc or a straight polyline segment. When you enter the Edit vertex option, an "X" marker appears on the screen at the first polyline vertex or point of tangency. The Edit vertex option contains the following suboptions:

- **Next.** Moves the "X" marker to the next vertex or point of tangency on the polyline.
- **Previous.** Moves the "X" marker to the previous vertex or point of tangency on the polyline.
- **Break.** Breaks the polyline between two vertices or points of tangency.
- **Insert.** Adds a new polyline vertex at a selected point.
- **Move.** Moves a polyline vertex to a new location.
- **Regen.** Generates the revised version of the polyline.
- **Straighten.** Straightens a polyline arc segment or multiple segments between two points.
- **Tangent.** Specifies a tangent direction for curve-fitting with the Fit option of the PEDIT command.
- **Width.** Changes the width of a polyline segment.
- **eXit.** Returns to the PEDIT command prompt.

Only the current point identified by the "X" marker is affected by editing functions. In Figure 14-12, the marker is moved clockwise through the points using the Next option and counterclockwise using the Previous option. If you edit the vertices of a polyline and nothing appears to happen, use the Regen option to regenerate the polyline.

Making breaks in a polyline

You can break a polyline into two separate polylines with the Break option of the PEDIT Edit vertex option. Once the Edit vertex option is entered, use the Next or Previous option to move the "X" marker to the first vertex where the polyline is to be broken. Enter the Break option. A marker is placed at the first break point. After moving to the second vertex of the break, enter the Go option.

The Go option instructs AutoCAD to remove the portion of the polyline between the two points. You can also break the polyline without removing a segment by specifying Go without moving to a second vertex. The results of the following command sequence are illustrated in Figure 14-13. The polyline was drawn clockwise.

Figure 14-12. Using the Next and Previous vertex editing options to specify polyline vertices. Note the different positions of the "X" marker.
Figure 14-13.
Using the Break vertex editing option to break a polyline and remove a portion.

Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit] <N>: (use Next to move to Point 1)

Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit] <N>: B.↓
(speckifies Point 1)

Enter an option [Next/Previous/Go/eXit] <N>: P.↓ (specifies Point 2)

Enter an option [Next/Previous/Go/eXit] <P>: J.↓ (specifies Point 3)

Enter an option [Next/Previous/Go/eXit] <P>: J.↓ (specifies Point 4)

Enter an option [Next/Previous/Go/eXit] <P>: G.↓ (breaks the polyline between Points 1 and 4)

Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit] <P>: ???

Inserting a new vertex in a polyline
A new vertex can be added to a polyline using the Insert vertex editing option. The new vertex can be inserted on an existing polyline segment, but does not need to be. First, use the Next or Previous option to locate the vertex next to where you want the new vertex. Select the Insert option and pick the new vertex location. See Figure 14-14.

Moving a polyline vertex
The Move vertex editing option enables you to move a polyline vertex to a new location. The “X” marker must first be placed on the vertex you want to move. Enter the Move option and specify the new vertex location. See Figure 14-15.

Straightening polyline segments or arcs
The Straighten vertex editing option allows you to straighten polyline segments or arcs between two points. Position the “X” marker at one end of the polyline segment to be straightened and enter the Straighten option. The Straighten option has four suboptions: Next, Previous, Go, and Exit. Use the Next and Previous options to position the “X” marker at the end of the segment to be straightened. Then enter the Go option to straighten the polyline segment. If the “X” marker is not moved before G is entered, AutoCAD straightens the segment from the marked point to the next vertex. This provides a quick way to straighten an arc. See Figure 14-16.
Changing polyline segment widths

The **Width** vertex editing option is used to change the starting and ending widths of an individual polyline segment. To change a segment width, move the “X” marker to the beginning vertex of the segment to be altered. Enter the **Width** option and specify the new width.

The default starting width value is the current width of the segment to be changed. The default ending width value is the same as the revised starting width. If nothing appears to happen to the segment when you specify the ending width and press [Enter], enter the **Regen** option to have AutoCAD draw the revised polyline. See **Figure 14-17**.

**Exercise 14-6**

Complete the exercise on the Student CD.

**Figure 14-17.**
Changing the width of a polyline segment with the **Width** vertex editing option. Use the **Regen** option to display the change.
Fitting a Curve to a Polyline

In some situations, you may need to convert a polyline into a series of smooth curves. One example of this is a graph. A graph may show a series of plotted points as a smooth curve rather than straight segments. This process is called *curve fitting* and is accomplished using the *Fit* option and the *Tangent* vertex editing option of the `PEDIT` command. The *Fit* option creates a *fit curve* by constructing pairs of arcs that pass through control points. You can specify the control points, or you can use the vertices of the polyline.

Prior to curve fitting, each vertex can be given a tangent direction. AutoCAD then fits the curve based on the tangent directions you set. You do not, however, need to enter tangent directions. Specifying tangent directions is a way to edit vertices when the *Fit* option of the `PEDIT` command does not produce the best results.

The *Tangent* vertex editing option is used to edit tangent directions. After entering the `PEDIT` command and the *Edit vertex* option, move the "X" marker to the first vertex to be changed. Enter the *Tangent* option and enter a tangent direction in degrees or pick a point in the expected direction. An arrow placed at the vertex then indicates the direction you chose.

Continue by moving the marker to each vertex you want to change, entering the *Tangent* option for each vertex, and selecting a tangent direction. When the tangent directions have been specified for all vertices to be changed, enter the *Fit* option of the `PEDIT` command to create the curve.

You can also enter the `PEDIT` command, select a polyline, and then enter the *Fit* option without adjusting tangencies, if desired. The polyline shown in Figure 14-18 was made into a smooth curve using the *Fit* option. If the resulting curve does not look like what you had anticipated, enter the *Edit vertex* option. Make changes using the various vertex editing options, as necessary.

Using the Spline Option

When you edit a polyline with the *Fit* option of the `PEDIT` command, the resulting curve passes through each of the polyline's vertices. The *Spline* option of the `PEDIT` command also smoothes the corners of a straight-segment polyline. This option, however, produces different results. It creates a *spline curve* that passes through the first and last control points or vertices only. The curve *pulls* toward the other vertices, but does not necessarily pass through them. The results of using the *Fit* and *Spline* options on a polyline are illustrated in Figure 14-19.

The *Spline* option creates a curve that approximates a true B-spline. You can choose between two types of calculations to create the curve—cubic and quadratic. A *cubic curve* is extremely smooth. A *quadratic curve* is not as smooth as a cubic curve, but it is smoother than a curve produced with the *Fit* option. Like a cubic curve, a
quadratic curve passes through the first and last control points. The remainder of the
curve is tangent to the polyline segments between the intermediate control points, as
shown in Figure 14-20.

The SPLINETYPE system variable determines whether AutoCAD draws cubic or
quadratic curves. The default setting is 6. At this setting, a cubic curve is drawn when
using the Spline option of the PEDIT command. If the SPLINETYPE system variable is set
to 5, a quadratic curve is generated. The only valid values for SPLINETYPE are 5 and 6.

**NOTE**

Both the Fit option and the Spline option of the PEDIT command create approximations of a B-spline curve. To create a true B-spline curve, use AutoCAD's SPLINE command instead. The SPLINE command is described in Chapter 15.

**Exercise 14-7**

Complete the exercise on the Student CD.

The SPLINESEGS system variable controls the number of line segments used to
construct spline curves. It can be set by typing SPLINESEGS or by entering a value in the Segments in a polyline curve text box in the Display resolution area of the Display tab of the Options dialog box. The SPLINESEGS default value is 8, which creates a
fairly smooth spline curve with moderate regeneration time. If you decrease the value, the resulting spline curve is less smooth. The resulting spline curve is smoother if you increase the value, but the regeneration time and drawing file size increase. The relationship between SPLINESEGS values and spline curves is shown in Figure 14-21.

**Exercise 14-8**

Complete the exercise on the Student CD.

**Straightening All Segments of a Polyline**

The Decurve option of the PEDIT command returns a polyline edited with the Fit or Spline options to its original form. The information entered for tangent directions is kept, however, for future reference. You can also use the Decurve option to straighten the curved segments of a polyline. See Figure 14-22.

**PROFESSIONAL TIP**

If you make a mistake while editing a polyline, remember that the PEDIT command includes an Undo option. Using the Undo option more than once allows you to step backward through each operation.

**Exercise 14-9**

Complete the exercise on the Student CD.

**Figure 14-22.**

The Decurve option of the PEDIT command is used to straighten the curved segments of a polyline.
Changing the Appearance of Polyline Linetypes

The **Ltype gen** (linetype generation) option of the **PEDIT** command determines how linetypes other than Continuous appear in relation to the vertices of a polyline. For example, when a Center linetype is used and the **Ltype gen** option is disabled, the polyline has a long dash at each vertex. When the **Ltype gen** option is activated, the polyline is generated with a constant pattern in relation to the polyline as a whole. The difference between having the **Ltype gen** option off and on is illustrated in **Figure 14-23**.

You can also change the **Ltype gen** option setting for new polylines with the **PLINEGEN** system variable. This variable must be set before the polyline is drawn. Changing the setting does not affect existing polylines. The settings for the **PLINEGEN** system variable are 0 (off) and 1 (on).

![Figure 14-23. A comparison of polylines and splined polylines with the Ltype gen option of the PEDIT command on and off.](image)

Exploding a Polyline

The **EXPLODE** command allows you to change a polyline into a series of individual lines and arcs. You can then edit each segment individually. The resulting segments are not, however, polylines. When a wide polyline is exploded, the width is lost and the resulting line or arc is redrawn along the centerline of the original polyline. See **Figure 14-24**.

![Figure 14-24. Exploding a wide polyline causes it to lose width information.](image)
To explode an object, pick the **Explode** button on the **2D Draw** control panel of the **Dashboard** or the **Modify** toolbar, select **Modify > Explode**, or type **X** or **EXPLODE**. AutoCAD asks you to select the objects to be exploded.

The **EXPLODE** command removes all width characteristics and tangency information. If you explode a wide polyline, AutoCAD reminds you of this fact. Using the **UNDO** command restores the polyline.

**Exercise 14-10**
Complete the exercise on the Student CD.

---

**Creating a Polyline Boundary**

When you draw an object with the **LINE** command, each line segment is a single object. You can create a polyline boundary from line segments that form a closed area using the **BOUNDARY** command. To do so, pick **Draw > Boundary...** from the pull-down menu or type **BO** or **BOUNDARY**. This displays the **Boundary Creation** dialog box. See Figure 14-25.

The **Object type** drop-down list contains two options—**Polyline** and **Region**. The **Polyline** option is the default and creates a polyline around the area. If you select **Region**, AutoCAD creates a **region** that can be used for area calculations, shading, extruding a solid model, or other purposes.

In the **Boundary set** drop-down list, the **Current viewport** setting is active. A **boundary set** is the portion or area of the drawing that AutoCAD evaluates when defining a boundary. The **Current viewport** option defines the boundary set from everything visible in the current viewport, even if it is not in the current display. The **New** button, located to the right of the drop-down list, allows you to define a boundary set. When you pick this button, the **Boundary Creation** dialog box closes and the **Select objects:** prompt appears. You can then select the objects you want to use to create a boundary set. After you are done, press **[Enter]**. The **Boundary Creation** dialog box returns with **Existing set** active in the **Boundary set** drop-down list. This means the boundary set is defined from the objects you selected.

The **Island detection** setting specifies whether objects within the boundary are used as boundary objects. Closed areas inside a boundary are called **islands**. See Figure 14-26. When **Island detection** is checked, islands within a boundary will be detected and turned into separate boundaries.
When you define a boundary set, you can include or exclude islands.

The only other active feature in the Boundary Creation dialog box is the Pick Points button, which is located in the upper-left corner. When you pick this button, the Boundary Creation dialog box closes and the Pick internal point: prompt appears. If the point you pick is inside a closed polygon, the boundary is highlighted, as shown in Figure 14-27. The Boundary Definition Error alert box appears if the point you pick is not within a closed polygon. Pick OK and try again.

Unlike an object created with the Join option of the PEDIT command, a polyline boundary created with the BOUNDARY command does not replace the original objects from which it was created. The polyline traces over the defining objects with a polyline. The separate objects still exist underneath the newly created boundary. To avoid duplicate geometry, move the boundary to another location on the screen, erase the original defining objects, and then move the boundary back to its original position.

**PROFESSIONAL TIP**

Area calculations can be simplified by using the BOUNDARY command or joining objects with the Join option of the PEDIT command before issuing the AREA command. Use the Object option of the AREA command to perform the area calculation. The AREA command is covered in Chapter 13. If you want to retain the original separate objects, explode the polyline after the area calculation if you used the Join option of the PEDIT command. Erase the polyline boundary after the calculation if you used the BOUNDARY command.
The `TRACE` command creates objects similar to polylines, but the `TRACE` command is difficult to access and trace objects are difficult to edit. In nearly all situations, it is better to use polylines in your drawings.

The `SKETCH` command provides another method of drawing objects with multiple segments. This command has some unique options and methods. In most situations, using lines, polylines, and splines in the drawing is more effective than using the `SKETCH` command.

**Chapter Test**

Answer the following questions. Write your answers on a separate sheet of paper or complete the electronic chapter test on the Student CD.

1. How do you draw a filled arrow using the `PLINE` command?
2. Which `PLINE` command option allows you to specify the width from the center to one side?
3. What is an advantage of leaving solid fills turned off?
4. Which system variable controls the automatic conversion of lines and arcs to polylines when they are selected within the `PEDIT` command?
5. Which two `PEDIT` command options allow you to open a closed polyline and close an open polyline?
6. Name the command required to turn three connected lines into a single polyline.
7. When you enter the **Edit vertex** option of the `PEDIT` command, where does AutoCAD place the "X" marker?
8. How do you move the "X" marker to edit a different polyline vertex?

For Questions 9 through 15, name the **Edit vertex** option of the `PEDIT` command that relates to the definition given.

9. Moves the "X" marker to the next position.
10. Moves a polyline vertex to a new location.
11. Breaks a polyline at a point or between two points.
12. Generates the revised version of a polyline.
13. Specifies a tangent direction.
15. Returns to the `PEDIT` command prompt.

16. Which `PEDIT` command option and suboption allow you to change the starting and ending widths of a polyline?
17. Why might it appear that nothing happens when you change the starting and ending widths of a polyline?
18. Name the `PEDIT` command option and the **Edit vertex** suboption used for curve fitting.
19. Can you use the **Fit** option of the `PEDIT` command without using the **Tangent** vertex editing suboption first? Explain.
20. Explain the difference between a fit curve and a spline curve.
21. Compare a quadratic curve, cubic curve, and fit curve.
22. Describe the appearance of a quadratic curve.
23. Which **SPLINETYPE** setting allows you to draw a cubic curve?
24. Which `SPLINETYPE` system variable setting allows you to draw a quadratic curve?
25. Name the system variable that can be set to adjust the smoothness of a spline curve.
26. Name the pull-down menu selections used to access the polyline editing options.
27. Explain how you can adjust the way polyline linetypes are generated using the `PEDIT` command.
28. Name the system variable that allows you to alter the way polyline linetypes are generated.
29. Which command removes all width characteristics and tangency information from a polyline?
30. Name the command used to create a polyline boundary.

Drawing Problems

1. Use the `PLINE` command to draw the following object with a .032 line width. Do not draw dimensions. Save the drawing as P14-1.

2. Use the `PLINE` command to draw the following object with a .032 line width. Do not draw dimensions. Save the drawing as P14-2.
3. Use the `PLINE` command to draw the following object with a .032 line width. Do not draw dimensions. 
   A. Deactivate solid fills and use the `REGEN` command, and reactivate solid fills and reissue the `REGEN` command. 
   B. Observe the difference with solid fills enabled. 
   C. Save the drawing as P14-3.

![Drawing 3](image)

4. Use the `PLINE` command to draw the filled rectangle shown below. Do not draw dimensions. Save the drawing as P14-4.

![Drawing 4](image)

5. Draw the objects shown below. Do not draw dimensions. Save the drawing as P14-5.

![Drawing 5A](image)  
![Drawing 5B](image)

6. Draw the object shown below. Do not draw dimensions. Set decimal units; .25 grid spacing; .0625 snap spacing; and limits of 11,8.5. Save the drawing as P14-6.

![Drawing 6](image)
7. Open P9-10 and add the arrowheads. Draw one arrowhead using the PLINE command, and then use the necessary editing commands to place the rest. Refer to the original problem. Save the drawing as P14-7.

8. Draw the flow chart shown below. Use polylines to draw the connecting lines, arrows, and diamonds. Use AutoCAD’s grid and snap to locate points. Save the drawing as P14-8.
9. Draw the flow chart shown below. Use polylines to draw the connecting lines, arrows, and diamonds. Use AutoCAD's grid and snap to locate points. Save the drawing as P14-9.

10. Draw the single polyline shown below. Use the Arc, Width, and Close options of the PLINE command to complete the shape. Set the polyline width to 0, except at the points indicated. Save the drawing as P14-10.
11. Draw the two curved arrows shown below using the **Arc** and **Width** options of the **PLINE** command. The arrowheads should have a starting width of 1.4 and an ending width of 0. The body of each arrow should have a beginning width of .8 and an ending width of .4. Save the drawing as P14-11.

![Curved Arrows](image1)

12. Open drawing P14-10 and make a copy of the original object to edit. Use the **PEDIT** command to change the object drawn into a rectangle. Use the **Decurve** and **Width** options and the **Straighten, Insert**, and **Move** vertex editing options of the **PEDIT** command. Save the completed drawing as P14-12.

![Curved Arrow](image2)

13. Open drawing P14-11 and make the following changes. Save the drawing as P14-13.

   A. Combine the two polylines using the **Join** option of the **PEDIT** command.
   B. Change the beginning width of the left arrow to 1.0 and the ending width to .2.
   C. Draw a polyline .062 wide, similar to Line A, as shown.

![Curved Arrow](image3)

14. Draw a polyline .032 wide, using the following absolute coordinates.

<table>
<thead>
<tr>
<th>Point</th>
<th>Coordinates</th>
<th>Point</th>
<th>Coordinates</th>
<th>Point</th>
<th>Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1,1</td>
<td>5</td>
<td>3,3</td>
<td>9</td>
<td>5,5</td>
</tr>
<tr>
<td>2</td>
<td>2,1</td>
<td>6</td>
<td>4,3</td>
<td>10</td>
<td>6,5</td>
</tr>
<tr>
<td>3</td>
<td>2,2</td>
<td>7</td>
<td>4,4</td>
<td>11</td>
<td>6,6</td>
</tr>
<tr>
<td>4</td>
<td>3,2</td>
<td>8</td>
<td>5,4</td>
<td>12</td>
<td>7,6</td>
</tr>
</tbody>
</table>

Copy the polyline three times so there are four polylines. Use the **Fit** option of the **PEDIT** command to smooth the first copy. Use the **Spline** option of the **PEDIT** command to turn the second copy into a quadratic curve. Make the third copy into a cubic curve. Use the **Decurve** option of the **PEDIT** command to return one of the three copies to its original form. Save the drawing as P14-14.
15. Use the PLINE command to draw a patio plan similar to the one shown in Example A below. Draw the house walls 6" wide. Copy the drawing three times and use the PEDIT command to create the remaining designs shown. Use the Fit option for Example B, a quadratic spline for Example C, and a cubic spline for Example D. Change the SPLINETYPE system variable as required. Save the drawing as P14-15.

16. Open drawing P14-15 and create four new patio designs. This time, use grips to edit the polylines and create designs similar to Examples A, B, C, and D below. Save the drawing as P14-16.